DS3002, DS3008 and DS8000 networked sound masking, paging and music processors with Privacy Manager software
# Contents

## Introduction / System overview
- Sound masking systems by DynasoundPRO 4
- Speaker Layout and Identification 8

## DynasoundPRO Privacy Manager software
- Installing Privacy Manager 9
- Connecting your PC to the sound masking network 9
- **Privacy Manager software** 10
  - Home / Monitor screen 13
  - Quick adjustment utilities 14
  - System Profiles 15
- **Inputs** 16
- **Sound masking** 17
- **Outputs** 17
  - Device properties 18
  - Transmit and receive settings 19
- **Control Groups** 20
- **Loudspeaker Zones** 22
  - Sound masking Schedules 24
  - Soft-Start Schedules 25
  - Saving Device firmware and System settings 26
  - Saving and Restoring Device and Total System Configurations 27
- **Using QtPRO Active Emitters with DynasoundPRO Network Systems** 28

## DynasoundPRO DS3002 / DS3008 / DS8000 hardware
- DS3002 and DS3008 30
- Paging and music connections to the DS3002/DS3008 processors 30
- DS8000 31
- Block Diagrams and Specifications 32
- Contact closure module - Fire Alarm Mute / Loading SavedConfigurations 36
- Initial Installation and Configuration 40
- DS3002, DS3008, DS8000 Specifications 41
- Network System Configuration Notes 42
- Tech Support 43
IMPORTANT SAFETY INFORMATION

Read these instructions.
Keep these instructions.
Heed all warnings.
Follow all instructions.
Do not use this apparatus near water.
Clean only with a dry cloth.
Do not block any of the ventilation openings. Install in accordance with manufacturer’s instructions.
Do not install near any heat sources such as radiators, heat registers, stoves or other apparatus that create heat.
Only use the attachments/accessories as specified by the manufacturer.
Refer all servicing to qualified personnel. Servicing is required when the apparatus has been damaged in any way, such as power supply cord has been damaged, liquid has been spilled or objects have fallen into the apparatus, the apparatus has been exposed to rain or moisture, does not operate normally or has been dropped.

DynasoundPRO Sound Masking Systems

Congratulations on your selection of DynasoundPRO equipment. This equipment represents the latest advances in sound masking technology. The DS3002 and DS3008 processors can be used for traditional centralized sound masking systems or for state-of-the-art networked addressable systems. The DS8000 PoE speaker controllers introduce an unprecedented level of control to the sound masking industry.

Centralized systems

Centralized sound masking systems consist of a masking generator with equalizer, a mixer for paging inputs, and an audio power amplifier hard wired to predetermined zones of speakers. DS3002 and DS3008 processors incorporate four separate sound masking generators, each having 1/3 octave band equalization. Balanced audio inputs and outputs and multi-channel matrix mixers make the DS3002 / DS3008 processors an ideal choice for complex centralized masking and paging systems.

Addressable systems

An addressable sound masking, paging and music system incorporates very little centralized equipment. Instead of a central rack of generators, mixers and amplifiers, the system is comprised of speakers which are networked together. The mark of a well designed system is that every speaker can be individually controlled. Poorly designed network system often cluster groups of speakers on a single audio output.

Hybrid systems

DynasoundPRO sound masking processors provide balanced analog audio outputs and CobraNet digital network audio outputs. This means they can be the central control, paging and music inputs location for systems using both standard 70 volt lines and networked speakers.

CobraNet is the registered trademark of Cirrus Logic.
Windows is a registered trademark of Microsoft.
What’s new with this Privacy Manager Release?

Privacy Manager 12.3 adds features to the existing DS8000 v3 firmware and support for the new DS8000 v4 firmware. For v3 firmware, there is continued support for the 125 Hz to 10K sound masking equalizer and the new capability to change the sound masking EQ to 100 Hz to 8K.

DS8000 v4 firmware provides a dedicated masking generator per speaker with each equalizer having a range of 100Hz to 10K. Version 4 firmware, while providing only 1 incoming page signal does allow the single paging channel to be adjusted per speaker. For most applications v3 software remains the overall best solution. Block diagrams for DS8000 v3 and DS8000 v4 firmware are provided on pages 32 and 33.

Privacy Manager 12.3 provides new “Linking” and “Mirroring” of Input, Output and Sound masking equalizer controls. The “Link” option ties together individual controls or “sliders” while the “Mirror” option will synchronize all controls or sliders for Input, Output and Masking Equalizer screens.

The demo mode for Privacy Manager 12.3 is enhanced to include the “Link” and “Mirror” functions.

The Input, Output and Sound Masking Equalizer screens now include obvious help prompts at the bottom of each screen to remind the user what mode is currently activated.

DynasoundPRO network sound masking
How it works....

DynasoundPRO networked systems feature a minimum of parts and pieces yet provide the most flexible and adjustable sound masking system available. The entire system consists of four easy to understand components:

1) DS3002/DS3008 sound masking, paging and music processor
2) DS8000 PoE speaker controllers
3) DS1356, DS1398 or DS1320 speakers
4) PoE network switches

CobraNet audio networking capability provides up to 32 channels of networked digital audio. The DS3002 / DS3008 is used to input standard audio signals, such as paging or music into the audio network. In the default configuration, the sound masking generators in the DS8000s are active. The DS3002 / DS3008 is typically used to broadcast paging signals only.

The DS8000 speaker controllers receive power and network audio through the CAT-5 network cable. Each DS8000 is capable of receiving up to eight audio channels. The DS8000 incorporates full DSP (digital signal processing) and can route any mix of the eight audio channels to any individual speaker or group of speakers. In addition, each speaker has individual access to the four internal masking generators inside each DS8000.
DynasoundPRO networked sound masking over-view

**Main Network System Components**

**DynasoundPRO DS1356** speakers wire directly to DS8000 networked speaker controllers using standard two conductor audio cable. DynasoundPRO DS1398 speakers may also be used with network systems.

**DynasoundPRO DS8000** speaker controllers are PoE, 8 channel network receivers including full DSP and internal sound masking generators. They are connected using standard CAT-5 connections.

**Industry standard PoE switches** and cables are used. Expensive managed switches are not required. Switches used for data flow only may be standard, non-PoE network switches. Switches that support routing will require the routing function to be disabled.

**Sound masking, Paging, Music Processor**

**DynasoundPRO DS3002 and DS3008** sound masking processors are used to route analog signals such as paging and background music into or out of the digital audio network. Network systems can use broadcast sound masking from the DS3008 or localized masking generated internally in the DS8000s, or both.

**Automation and Control**

**Touch screen PC** is used to control and automate system functions and schedules. Privacy Manager software provides the ability to easily adjust sound levels system-wide, per zone or per speaker. Functions include the ability to assign multiple sound masking schedules, system profiles and even automatically run system profiles on a timed basis.

**Contact Closure Module** is used to initiate various system functions using external contact closure. The most common usage is to mute the masking system during fire alarms or emergency announcements. Other uses include loading stored system configurations using contact closure from external switches or audio-video controllers.
DynasoundPRO networked sound masking over-view

- DS1356 speakers
- DS8000
- PoE switch
- Cat 5 cable
- Touch screen controller with Privacy Manager Software
- DS3008 Soundmasking, Paging and Music Processor
- speakers wired with 18-2 standard speaker cable
Example speaker identification - networked systems

A drawing showing DS8000 and DS1356 speaker locations is required to make adjustments to individual speakers or Control Zones. This example represents four DS8000s labeled 1.1, 1.2, 2.1 and 2.2. The typical naming convention for the system is to label each DS8000 with the floor number and sequential ID. In this example the DS8000s are labeled in two groups even though on the same floor.

While there is flexibility in the naming convention, the goal is to make it easy to reference a particular DS8000 and the speakers attached to it.

These screens show connection to the DS8000 having an IP address 192.168.100.6. The Output Manager screen indicates that speaker 1 is selected. The Output Manager screen also illustrates the level of control available. Note that individual speakers have access to eight network audio channels and four independent masking generators.

These screen above shows the quick utility to adjust the volume of speaker 1 connected to DS8000 number 1.1. On the drawing that speaker is labeled 1.1.1.
Privacy Manager - Installation and Configuration

If Privacy Manager is already installed and configured you can skip this section and proceed to the next page. If not proceed as follows:

Insert the USB drive provided with the DS3002/DS3008/DS8000. Open the drive and run the setup program provided. You can also download Privacy Manager from http://cambridgesound.com/dynasound-privacy-manager-software/.

Configuring Privacy Manager for your sound masking network

The default IP search range is set to the default IP address of a DS3002 or DS3008 (192.168.100.5). If additional devices are being used the range of IP addresses in your system must be entered into the Network Setup screen.

If there are unused IP addresses between the starting and ending numbers, the unused numbers should be entered into the exclusion field so that, during operation, Privacy Manager software is not delayed attempting to locate non-existing devices. For exception IP addresses enter only the last segment of the IP address. Complex exceptions may be specified similar to page numbers in a word processor. For example you could exclude devices 5,8,10-15,20 which would exclude IPs ending in 5,8,10,11,12,13,14,15 and 20.

Connecting your computer to the sound masking network

Communications between the Windows based PC, the DS3002/3008 and networked DS8000s are done via a 100 base-T switched network. You must set your PC Network Interface Card to a fixed IP as shown below. The DS3002/DS3008 default factory IP address 192.168.100.5. Default IP addresses for DS8000s are 192.168.100.6 through 192.168.100.200. You should set your computers network IP to a fixed IP, out of the range of other network devices, such as 192.168.100.240.
Privacy Manager - firmware v2 and v3

Privacy Manager software is used to control DS3002, DS3008 and DS8000 series sound masking products. Privacy Manager runs on Windows operating systems.

Home Screen

- Menu Bar
- Quick Adjustment
- Link / Mirror Options
- Device List
- Help prompts

The home screen provides access to system management features and lists the individual network devices.

Device Screens (DS3002, DS3008 firmware v2, DS8000 firmware v3)

Sound masking

1/3 Octave Band EQ for sound masking generators

Inputs

- Input level control, Octave Band EQ and compressor for paging and music

Outputs

- 12 channel audio mixers for each output provide the ability to customize masking, music and paging levels throughout the network on a per speaker basis. When connected to a DS8000 the twelve channel mixer is available to each speaker.

Most network devices include four individual sound masking generators, independent input independent output processing. Such devices include DS3002, DS3008 with firmware versions 2 and DS8000s with firmware version 3.
Sound Masking EQ - DS8000 firmware v3

DS8000 firmware v3 sound masking equalizers can be set for either 125 Hz to 10 kHz, or 100 Hz to 8 kHz. The choice must be consistent within a given control zone.

To select the equalizer center frequencies, and in order to maintain consistent settings with a zone, you must select the desired zone and link option before selecting the desired EQ range.

For more information on the Link and Mirror options and how they should be used see page 20.
**Privacy Manager - DS8000 firmware v4**

Firmware version 4 does not use separate screens for Input, Output and Sound Masking EQ. Version 4 is designed for maximum tunability providing a dedicated generator and EQ for each speaker output.

**Home screen**

- **Menu Bar**
- **Quick Adjustment**
- **Control Zone Link & Mirror options**
- **Device List**
- **Help prompts**

The home screen provides access to system management features and lists the individual network devices.

**Device screen (DS8000 firmware v4)**

- **Sound masking, Input and Output**

DS8000s loaded with firmware v4 include eight individual sound masking generators with EQ from 100 Hz to 10k.

Version 4 firmware provides for only one incoming audio channel. The channel is selected from the device configuration screen. Each speaker has individual volume for the incoming network audio signal.
Home screen

The home screen appearance can be modified to suit user preferences. The Home Screen device list includes system information and access to individual network devices.

Home screen views

The View menu offers various the ability to display or hide various system information.

• Quick Adjustment utilities
• System Presets
• User notes on device list
• Transmit and Receive settings on device list
• firmware version on device list
• Schedule and Level information
• Soft Start status
• Speaker Type (DS1356 or Active Emitter)
• Expanded device list

Home screen monitor - DS3002, DS3008 firmware v2 and DS8000 firmware v3

In monitor view the sound masking, input and output levels are graphically represented. Monitor view provides an easy way to browse up and down the device list verifying the desired signal flow.

Home screen monitor - DS8000 firmware v4

In firmware v4 monitor view displays the active input channel and each individual speaker output. Monitor view provides an easy way to browse up and down the device list verifying the relative speaker levels.
Quick adjustment buttons

The three most common system adjustments may be done from the home screen, without the need to enter the individual device screens. Once the system is configured, these features will satisfy most routine adjustment needs.

Adjusting all sound masking levels

Sound masking levels may be changed system wide using the screen shown to the left. After selecting the “Adjust all masking levels” button this screen appears and facilitates the entry of an adjustment factor to the sound masking levels. For example, if you wish to lower all sound masking levels by 2 decibels, you would press the “lower” button until the display indicates minus 2. Clicking the “submit changes” button applies the change to the system. This utility reads all of the active sound masking generators in the system and applies the change to their various current levels.

Adjusting sound masking levels by Control Group

Sound masking levels may be changed per Control Group using the screen shown to the left. After selecting the “Adjust masking for a Control Group” button this screen appears and facilitates the entry of an adjustment factor to the sound masking levels. For example, if you wish to lower all sound masking levels within a Control Group by two decibels, you would press the Control Group select buttons to choose the desired Control Group. Then click the “down level” button until the display indicates minus 2. Clicking the “submit changes” button applies the change to the selected Control Group. This utility reads all the active sound masking generators in the zone and applies the change to their various current levels. The Control Group may also be muted using this feature.

Adjusting an individual speaker level

Sound levels may be changed per speaker using the screen shown to the left. After selecting the “Adjust an Individual speaker” button this screen appears and facilitates the entry of an adjustment factor to the selected speaker. For example, if you wish to raise the level for a specific speaker by 1.5 decibels, you would select the proper DS8000 speaker controller and the speaker you wish to adjust. The IP address and location is shown for each available DS8000. After using the “raise” button to select a change of 1.5 dB, click the “submit changes” button to apply the change to the selected speaker. This utility displays the current setting, before and after making the per speaker change. Individual speakers may also be muted using this feature.
System profiles

System profiles are used to store previously saved configurations for quick recall at the touch of a button. Up to eight user defined system profiles may be stored. Profiles may be saved and applied system wide or for a specific zone only.

Loading saved system profiles

System profiles provide a user friendly way to recall system-wide configurations. To recall a previously saved profile simply select the desired button. You will be prompted to verify that you wish to replace the current profile with the selected profile.

Loading system profiles may also be done from the main drop down menu. Keyboard command shortcuts have been added to facilitate additional access methods.

Saving system profiles

System profiles provide a user friendly way to save system-wide configurations. The currently saved system configuration may be stored into one of the eight preset selections shown on the File menu. A system profile cannot be created if there are pending edits/system saves.

Profiles can only be created from System start-up settings which have been saved to non-volatile memory. If you edit any system settings the changes must be saved before using those settings to create a stored profile.

Profile schedules and settings

Saved system profiles may be configured to run on a scheduled basis. Unlike sound masking schedules which have “up” and “down” times, Profiles simply have a single time/day settings that triggers their start. A profile will stay in effect until another scheduled profile replaces it.

If the “Load scheduled profile on start” is selected, Privacy Manager will start the profile that should be running based on time of day and day of the week.
Device Controls - Inputs, Sound masking and Outputs

DS3002, DS3008 and DS8000 processors have similar sound masking, input and output processing and controls. The appearance of the display varies based on device type and firmware version.

Inputs - DS3002, DS3008 firmware v2, DS8000 firmware v3

The input manager is used to process the incoming audio signals, such as paging or music. The screen's appearance changes depending on the device being controlled. DS3002s and DS3008s include input compressors and the option of accepting an input via the balanced analog inputs or a CobraNet input. DS8000s always receive input via the network.

DS3002 / DS3008 Inputs - firmware v2

Select Input Manager by clicking the input button to access level controls, equalizers and compressors for each input channel. Use the drop-down list or touch screen buttons to change between input channels. The incoming signal may be either a line level input or a CobraNet audio input. The Input Manager does not route signals to any given output. Mixing and output routing is done with the Output Manager.

DS8000 Inputs - firmware v3

Shown on the left is the Input manager as it appears when connected to a DS8000. The view on the bottom right is the Input manager as it appears when the user selects input 7 or input 8. These two inputs are linked allowing A and B broadcast sound masking, or stereo music, to be adjusted together. EQ of the broadcast audio is done at the DS3002, DS3008 level.
In firmware v2 and v3 the equalizer controls for generators A and B are linked to provide two channel masking using one equalizer for tuning both A and B generators at the same time.

In DS8000 firmware version 4 each speaker output has a dedicated generator and EQ. All eight speakers may be linked for simultaneous adjustment.

**Outputs**

**DS3008 Outputs**

The output manager is used to process the signals routed to any given output channel. In the case of a DS3002 or DS3008 the output signals are both line level analog signals and CobraNet digital network audio signals.

**DS8000 v3 Outputs**

Note that the output manager for the DS8000 has a single output level relating to an individual speaker.
Device properties

Device properties, such as Zone ID, can be edited while connected to a specific DS3002/3008/8000. While connected to a device, click the configuration button to bring up the configuration window. Then double-click the field you wish to edit and enter the changes. The following device properties can be edited:

- location ID
- control zone
- transmit bundle ID
- receive bundle ID
- device IP address
- device notes
- sound masking schedule
- soft start schedule

1) location ID: The location is a text field that represents a physical location in the building and on the as-built drawings. It is used to identify the location of DS8000s. The normal naming convention is the floor number and a sequential number representing each DS8000. For example, the 3 ea. DS8000s on the third floor would be 3.1, 3.2, and 3.3.

2) control zone: Control Zone is a text field that can be various formats, however zone names are case-sensitive and care must be taken to properly group DS8000s into customized Control Zones.

3) transmit bundle ID: The default factory transmit bundle number for DS3002s and DS3008s is 2.

4) receive bundle ID: The default factory receive bundle number for DS8000s is 2.

Mismatched transmit and receive bundle numbers will result in no audio being delivered. There can be only one system Broadcaster for a given bundle. For example you could not have two DS3008s broadcasting on the same bundle number.

5) IP address: A static IP address is normally defined for each network device before shipping. Once a system is in place and configured there is normally no need to change an IP address.

Changing IP addresses can make the DS3002, DS3008 or DS8000 become unreachable. All IP addresses must fall within a range that is compatible with the setting on your PC’s network connection.

6) notes: This is a text field that is used to store user comments or notes for a specific device.

7) sound masking schedules: Sound masking schedules may be user defined to raise and lower sound masking levels based on time of day and day of the week. This setting applies a specific schedule to the DS8000. See Sound masking schedules for more information on modifying and enabling sound masking schedules. This feature requires a full time connected PC.

8) soft start schedule: The Soft Start schedule is a one-time schedule used to gradually introduce sound masking into an existing non-masked office. This process is generally not required for new facilities. It is used to facilitate the addition of sound masking to an already occupied environment. This feature requires a full time connected PC controller.
Device transmit and receive settings

The most common system configuration calls for a DS3008 sound masking processor used to introduce audio signals into the CobraNet network. DS8000 speaker controllers are used to receive and route the network audio bundles to any individual speaker or group of speakers. The incoming and outgoing signals are referred to as “bundles” instead of channels to avoid confusion as each bundle contains 8 audio channels.

More than one DS3008 or DS3002 may be used to introduce additional transmit bundles into the network allowing up to 32 audio channels on a single system.

Transmit bundle

DS3002 and DS3008 processors are used to broadcast network audio to the DS8000 speaker controllers. Network audio may include sound masking, paging and music. When using the DS3002/DS3008 to provide broadcast masking it should be routed through channels 7 and 8. Music or paging signals should be routed through channels 1-6.

The default bundle number for transmitting is 2.

Receive bundle

The default receive bundle number for a DS8000 is 2. Transmit and receive bundles may be shown on the home screen device list by selecting “transmit and receive” from the View menu at the top of the home screen.
It is important to understand how Control Zones function. In centralized systems, zones are hardwired. In network systems zones may be defined and redefined via software with no rewiring needed. This feature provides the ability to make adjustments to an entire zone at the same time. A DS8000 on the network can be assigned to any control zone. You must have a clear understanding of control zones and their behavior; and when you do and do not want to use them.

**What happens when “Link” is checked?**

The sound masking, input and output screens have differing behaviors when in Link mode. When a specific zone is selected, and Link Mode is chosen, any slider which is adjusted will cause all the matching sliders in the zone to be set to the same settings and as adjusted slider. For example if Link is selected, and the 1K slider is moved on the currently viewed DS8000, all 1K sliders in the rest of the DS8000s in the zone will be adjusted as well.

**What happens when “Mirror” is checked?**

The sound masking, input and output screens have differing behaviors when in Mirror mode. When a specific zone is selected, and Mirror Mode is chosen, moving ANY slider will cause ALL sliders in the zone to be set to the same settings as the sliders displayed on the current screen. For example if Mirror is selected, and a slider is moved on the currently viewed DS8000, all sliders in the rest of the DS8000s in the zone will be adjusted to mirror the current screen.
Control Groups

When NOT to use Control Group link features

Adjusting distributed masking generators per Control Zone.

Adjusting the distributed sound masking levels for a particular Control Zone illustrates the convenience of linking controls together. On networked systems that use the local generator/equalizers in the DS8000s it is beneficial to tune/adjust them as a group. When making adjustments intended for a single device be sure that the zone is not linked or mirrored.

Adjusting a single speaker.

An example of when not to use the Zone Linking or Mirror feature would be when adjusting an individual speaker level. For example if, on the screen to the left, the speaker level was adjusted while in “link” mode, each speaker number one would be raised for each DS8000 in the Control Zone.

Control Groups - Best Practices

Using the Control Group feature is a powerful way to quickly adjust multiple DS8000s. In the worst case scenario it can also be a way to inadvertently mass duplicate unwanted actions.

In general, using the linked mode will be most helpful when initially configuring a system.

Minor system adjustments such as raising or lowering the level of a speaker is best done in non-linked mode.

Raising or lowering sound masking levels per zone can be done via the user friendly home screen buttons, eliminating the need for most end users to worry about proper use of linking or mirror controls.
Loudspeaker Zones

Loudspeaker Zones are used to adjust the volume of a user-defined collection of speakers independent of which DS8000, or Control Group, they are attached to. While Control Groups provide the ability to control all aspects of the DS8000s assigned to them, Loudspeaker Zones provide only the ability to adjust the level, or volume, of the speakers. Loudspeaker Zones may be created with subsets of the Control Zones or across Control Zones. Any individual speaker may be assigned to a Loudspeaker Zone regardless of which DS8000 it is connected.

Enabling Loudspeaker Zones
Loudspeaker Zones can be enabled or disabled in the Setup tab of the System Setup screen which is available under the Home screen’s main menu.

Naming Conventions
Loudspeaker Zone names are stored in the DS8000 memory, not in the Privacy Manager PC. As such, the names of the Loudspeaker Zones are of limited length. The names consist of 3 characters. The first two are numeric (01-99) and the last is alpha (A-Z). Generally, the numeric portion of the name will coincide with a Control Group or Building Floor number.

Assigning Loudspeakers to Zones
When the Loudspeaker Zones option is enabled, individual speakers may be assigned to Loudspeaker zones using the output screen shown here. When assigning all eight speakers on a DS8000 to the same Loudspeaker Zone, use the checkbox below the speaker assignments to avoid having to set them all individually.

Adjusting the Volume Level of Loudspeaker Zones
The volume level of speakers assigned to a Loudspeaker Zone may be adjusted using the button and dialog box shown here. All speakers will be adjusted relative to their individual levels. Whatever change, plus or minus, is specified that change will be applied to each speaker’s current level. When this function is used, only the speakers which are member of the Loudspeaker Zone will be shown on the device list. The Loudspeaker Zone can also be muted and will return to the previous, per speaker, levels when un-muted.
Loudspeaker Zones

Loudspeaker Zones may be displayed on the device list of the Privacy Manager home screen.

Viewing Loudspeakers Zones from the Home Screen

Loudspeaker Zone information for each DS8000 may be displayed by selecting that option under the View menu on the Home screen.

When the View Loudspeaker Zones is selected from the View menu the status for all eight speakers will be displayed.
Sound masking schedules

Editing sound masking schedules

Sound masking levels may be scheduled to raise and lower at specific times of the day and day of the week. The schedules shown are the default schedules installed during Privacy Manager installation.

Seven schedules are available for modification and assignment to individual DS8000s as shown below.

Select the desired schedule and click the Edit button to display the edit screen shown here. Sound masking schedules have beginning and ending times. The days of the week they are active is also user selectable. Attenuation is the amount the sound masking will be lowered. Duration is the time it takes to change levels.

Assigning schedules

To assign any of the available seven sound masking schedules to an individual DS8000 simply double click the schedule text box and select the desired schedule.

Assigning schedules by zone

After selecting the zone you wish to assign the schedule, use the “choose masking schedule for selected zone” menu option. All DS8000s included in the selected zone will be added to the chosen masking schedule.
Soft Start schedules

Using the Soft-Start schedule

For environments where sound masking is being integrated into an existing non-masked environment it may be desirable to gradually introduce the masking levels.

Editing the Soft-Start schedule

Unlike reoccurring schedules, one time schedules do not repeat. User selectable criteria includes the start date, the amount of attenuation and the duration of the soft start in days. One schedule is available for assignment to individual DS8000s as shown below.

Assigning the Soft-Start schedule

After selecting the DS8000 you wish to assign the soft start schedule, use the "add the selected zone to soft start" menu option.

Assigning Soft-Start by zone

After selecting the zone to which you wish to assign soft start, use the "choose masking schedule for selected zone" menu option. All DS8000s included in the selected zone will be added to the chosen masking schedule.

DS8000s or Zones may be assigned to both reoccurring sound masking schedules and one-time Soft Start Schedules at the same time.
It is important to understand this feature. Saving a configuration to a PC file does not save the configuration to permanent memory in the DS3002, DS3008 or DS8000. To save the current DSP configuration to permanent memory select the “save start-up” button. Status is shown on the main screen during the save process.

Your PC connection must remain intact while saving configurations to the devices non-volatile firmware memory.

Device configurations must be saved to permanent, non-volatile memory, or upon restart (such as a building power failure) the device(s) will revert to the last saved configuration.

---

Saving System power-up settings.

It is important to understand this feature. Saving a configuration to a PC file does not save the configuration to permanent memory in the DS3002, DS3008 or DS8000. To save the current DSP configuration to permanent memory select the “save start-up” button. Status is shown on the main screen during the save process.

Your PC connection must remain intact while saving configurations to the devices non-volatile firmware memory.

---

Saving System power-up settings - Best Practices

The requirement to save the start-up settings of a system varies with the type and configuration of the system.

For a system that does not have a touch screen controller and only uses one configuration, it is essential that the start-up configuration be saved to permanent memory. If the configuration is not saved to start-up memory the system would default back to the factory settings after a power failure.

For a system that has a touch screen controller and uses sound masking schedules to vary the sound masking levels based on time of day and day of the week or a system that uses timed profiles there is less need to save any profile other than a default start-up profile. In the case of a power outage, the touch screen controller will set the system to the correct configuration shortly after power-up.

For systems that utilize timed profiles, there is an option to save the start up firmware settings after loading a profile. This is generally not advised. The reason it is offered is to give the user the option to save a profile that might change infrequently into start up memory so there is no delay in running that profile after a power failure. The reason it is not generally advised is that the touch screen controller will rerun the correct timed profile anyway within a short period of time. In this scenario, the permanently saved start up profile is of little importance, other than being acceptable during the brief system start up period.
Device configurations can be loaded using the standard Windows™ file navigation screens.

Device configuration files may only be saved or loaded while connected to a specific device.

It is important to note that significant level changes may occur when loading new configurations. The settings are applied as soon as the file is loaded.

Entire system configurations can be saved using the standard Windows™ file navigation screens. System configuration files may only be saved from the home screen. The save system settings to file process builds an archive file from the currently active device list. In order to save the information for all devices you must select All Zones and refresh.

In order to save all network device configurations to a disk file, ALL devices must be in the device list. After selecting “All Zones” and refreshing the device list, verify that Network Status is 100 percent before saving the system configuration.
Using QtPRO Active Emitters with DynasoundPRO Network Systems

DynasoundPRO networked sound masking systems support the use of QtPRO Active Emitter. This approach provides individual control, and multiple audio signals which can be controlled on a per-emitter basis. Audio signals, such as paging or music are connected to the sound masking network using a DS3002 or DS3008.

Displaying Speaker Type

The View menu has an option to display the speaker type. Current speaker types are DS1356 plenum speakers or Active Emitter. It is not required to display speaker type in order to change from one type to another.

Selecting Speaker Type

In order to change the speaker type from the default DS1356 to Active Emitter, one must select the zone to be changed. A zone may be created using a single DS8000 or multiple DS8000s. Once the desired zone is selected, choose the menu option shown here to set the zone for Active Emitter or for DS1356 speakers.

The following page describes the system changes which take place with each speaker type is selected.
Using QtPRO Active Emitters with DynasoundPRO Network Systems

Privacy Manager software makes configuring a zone for Active Emitters a simple process. When the desired zone is selected, and the Active Emitter speaker type is chosen, the sound masking EQ and Speaker Outputs are automatically configured as shown below:

Sound masking EQ

Similar to the Cambridge Sound QtPRO systems, DynasoundPRO network systems provide four independent sound masking channels (A through D). When Active Emitters are the chosen speaker type generators A-D are linked with a common EQ screen. In addition, a default sound masking curve is set to provide trouble free tuning for networked Active Emitter applications.

Outputs

To further simplify the Active Emitter setup process, speakers (emitters) are automatically routed to the A through D generators. Generator A is routed to emitters 1 and 5. Generator B is routed to emitters 2 and 6. Generator C is routed to emitters 3 and 7. Generator D is routed to emitters 4 and 8.

Steps to Change a Zone to Active Emitter

1) Select the zone you wish to configure for Active Emitters.
2) Select the menu option for change zone to Active Emitters.
3) Speaker type may be displayed on the home screen device list by selecting View Speaker type from the View menu.
4) Volume levels and audio signals may be controlled for each Emitter in the same way one would control other networked speaker types.
DynasoundPRO DS3002 and DS3008

The DynasoundPRO DS3008 is a network ready sound masking/paging/music processor incorporating four sound masking generators, eight balanced audio inputs, eight balanced audio outputs and a 12x8 matrix mixer allowing any combination of audio channels to be routed to any of 8 balanced outputs. The DynasoundPRO DS3002 is a similar device incorporating four sound masking generators, two balanced audio inputs, two balanced audio outputs and a 6x8 matrix mixer.

For use in networked masking/paging/music systems the DS3002 and DS3008 processors also provide eight channels of networked digital audio via CobraNet. Each input has a six band equalizer, and compressor. Each sound masking generator has separate 1/3 octave band EQ, high pass and low pass filters.

Physical installation of the DS3002 and DS3008

The DS3002/DS3008 is designed to fit standard 19 inch electronic equipment racks. No special cooling is required although the unit should not be operated in excessively hot, humid or harsh environments.

Controlling the DS3002/DS3008 from your PC

Direct connection between the DS3008/DS3002 and a PC may be accomplished using a standard cross-over cable (supplied). When used in a networked system the DS3002 or DS3008 and all DS8000s are accessed through the network.

Connecting paging, music or other audio inputs

The DS3002/DS3008 balanced inputs and outputs are on the rear panel. The connectors can be removed, for ease of wiring, and reinserted. Input impedance is nominally 5000 ohms.

When connecting an unbalanced line (two conductors) to a DS3002/DS3008 input or output use only the positive(+) and ground terminals, leaving the negative(-) position floating, or unused.

Typical telephone paging connection and operation

Do not connect digital or analog telephone extensions or ports directly into the DS3002 or DS3008 audio inputs. The balanced audio inputs are for line level audio signals only.

Most commercial telephone systems require a page adaptor in order to output an analog line-level audio signals suitable for connection to standard commercial paging amplifiers. The balanced inputs on the DS3002 and DS3008 processors are similar to those found on typical commercial audio amplifiers/mixers in that they accept audio signals only and do not process DTMF, loop start, ground start or other telephone protocols. The type of paging adaptor required depends on the type of phone system. For example, an IP based phone system would require a different page adaptor than an classic POTS system. However, the signal output from the adaptor would be similar; a line level audio signal suitable for input to a commercial paging amplifier. Information and support regarding commercial paging adaptors is available via companies such as Valcom (www.valcom.com) and Bogen (www.bogen.com)
DynasoundPRO DS8000

DS8000 firmware v3

The DynasoundPRO DS8000 is a PoE (Power over Ethernet) network controlled sound masking/paging/music processor incorporating four sound masking generators, eight network audio inputs, eight 4-8 ohm speaker outputs and a 12x8 matrix mixer allowing any combination of inputs and sound masking generators to be mixed to any of the eight speaker outputs. In addition, network inputs 1-6 each have dedicated 7 band equalizers. Each sound masking generator has separate 1/3 octave band EQ, high pass and low pass filters.

DS8000 firmware v4

DS8000s loaded with firmware version 4 have eight sound masking generators, a single network audio input and eight 4-8 ohm speaker outputs. A 9x8 matrix mixer allows individual speaker adjustment of masking and paging levels.

The DS8000 is designed to accept network audio signals from a DynasoundPRO DS3008 or DS3002 sound masking processor via standard network PoE switches.

Physical installation of the DS8000

The DS8000 is shipped with hardware for attachment to speaker suspension wires. For attachment to speaker hanging wires, the supplied "grid-wire" clip can be used.

Connecting speakers to the DS8000

The DS8000 provides eight speaker level outputs for connection to DynasoundPRO DS1356, DS1398 or QtPRO DS1320 speakers. Speaker connections are made with 2 conductor connectors. Wire should be minimum 18 gauge copper stranded. NOTE: The DS8000 is NOT intended for use with DS1338 speakers or any other 70 volt speakers. The DS8000 is intended for use with 4 through 8 ohm speakers or emitters only.

Connecting the DS8000 to the sound masking network

The DS8000 is the first networked sound masking system to be powered using Power over Ethernet (Poe). Connections are made using standard Cat 5 or Cat 6 cables. The network cable provides power and digital audio to the DS8000s.
The DS3002 provides two audio inputs which can be configured to be either analog or CobraNet. There are four internal sound masking generators, each having 1/3 octave EQ, high and low pass filters. A six input matrix mixer feeds eight output channels which are routed to both analog and CobraNet outputs.
The DS3008 provides eight audio inputs which can be configured to be either analog or CobraNet. There are four internal sound masking generators, each having 1/3 octave EQ, high and low pass filters. A twelve input matrix mixer feeds eight output channels which are routed to both analog and CobraNet outputs.
The DS8000 provides eight network audio inputs. There are four internal sound masking generators, each having 1/3 octave EQ, high and low pass filters. A twelve input matrix mixer feeds each speaker output.
DS8000 firmware version 4

Network Audio Inputs

- CobraNet in 1
- CobraNet in 2
- CobraNet in 3
- CobraNet in 4
- CobraNet in 5
- CobraNet in 6
- CobraNet in 7
- CobraNet in 8

Internal Soundmasking

- Sound masking 1
- Sound masking 2
- Sound masking 3
- Sound masking 4
- Sound masking 5
- Sound masking 6
- Sound masking 7
- Sound masking 8

Input Router 8x1

Matrix Mixer with Speaker Outputs

9 x 8 Matrix Mixer

- Level control → Speaker 1
- Level control → Speaker 2
- Level control → Speaker 3
- Level control → Speaker 4
- Level control → Speaker 5
- Level control → Speaker 6
- Level control → Speaker 7
- Level control → Speaker 8

DS8000
Contact Closure Module - Fire alarm mute & Profile Selection - DSCP8200

When using a PC controller which is connected to the sound masking network full time, Privacy Manager provides contact closure sensing to trigger various system functions. The most common usage is to mute the sound masking system when contact closure is provided by the fire alarm control panel. This is the most thorough method as it will mute all generators included in the central DS3002/DS3008 as well as generators residing in the DS8000s.

In addition to Fire Alarm Mute functions, the external module adds the ability to load previously stored profiles using contact closure from remote switches or external systems.

Contact closure must be enabled to use the fire alarm mute or profile options. Software settings for the contact closure module include the COMM Port used and 115200 baud rate. The polling interval can be specified. Available intervals are 3, 5, 10, 15, 30, 60 and 120 seconds.

No special routing, within the DSP, needs to be done to accommodate this method of fire-alarm muting. The controller will locate and mute all active masking generators.

The images below show the Privacy Manager configuration screen and typical installation of the external contact closure module. The module is manufactured by SuperLogics (www.superlogics.com). The part number is CP-8200.

Contact Closure Module DB25 pins

Fire Alarm mute contacts: pin 24 and pin 14
Profile 1 contacts: pin 12 and pin 1
Profile 2 contacts: pin 12 and pin 2
Profile 3 contacts: pin 12 and pin 3
Profile 4 contacts: pin 12 and pin 4
Profile 5 contacts: pin 12 and pin 5
Profile 6 contacts: pin 12 and pin 6
Profile 7 contacts: pin 12 and pin 7
Profile 8 contacts: pin 12 and pin 8
Instructions for Using the DSCP8200

The DSCP3200 includes:
1) Contact Closure Module
2) Contact Closure Power Supply
3) 9 pin Rs-232 cable
4) 25 pin solderless DB-25 connector.

1) Mount the contact closure module near the touch screen PC and connect the provided 9 pin com port cable to the contact closure and the touch screen PC com port.

2) Using the screw terminals on the DB-25 connector attach the two conductors, from the contact closure switch or fire alarm panel, to pins 14 and 24. Secure the contact closure wire by placing the strain relief clamp over the cable and tighten the two included short screws. Close the plastic case of the DB-25 connector.

3) Plug the DB-25 connector into the Digital Port on the Contact Closure Module and insert and screw the two long screws through the DB-25 connector and into the threaded portions of the Digital Port.

4) Configure Privacy Manager software as described on the preceding page. The LED in the contact closure should flash red at the same rate as the interval set in the software. The contact closure module will check the contact open/closed status on the specified interval only.
Contact Closure Module - Fire alarm mute & Profile Selection DS-CP8201

When using a PC controller which is connected to the sound masking network full time, Privacy Manager provides contact closure sensing to trigger various system functions. The most common usage is to mute the sound masking system when contact closure is provided by the fire alarm control panel. This is the most thorough method as it will mute all generators included in the central DS3002/DS3008 as well as generators residing in the DS8000s.

Contact closure must be enabled to use the fire alarm mute or profile options. Software settings for the contact closure module include the COMM Port used and 9600 baud rate. The polling interval can be specified. Available intervals are 3, 5, 10, 15, 30, 60 and 120 seconds.

No special routing, within the DSP, needs to be done to accommodate this method of fire-alarm muting. The controller will locate and mute all active masking generators.

The images below show the Privacy Manager configuration screen and typical installation of the external contact closure module. The module is manufactured by Weeder Technologies (www.weedtech.com). The part numbers are WTDIN-M (board), CASE-LG (plastic enclosure) and PWR-PACK (power supply). These items can be ordered from Cambridge Sound Management, as a kit, under the single part number DS-CP8201. The DS-CP8201 kit also contains a RS-232 cable for connection to the sound masking system touch screen controller.

Contact Closure Module Connections

Fire Alarm mute contacts: term A and GND
Future Use: term B and GND
Future Use: term C and GND
Future Use: term D and GND
Future Use: term E and GND
Future Use: term F and GND
Future Use: term G and GND
Future Use: term H and GND
Instructions for Using the DS-CP8201

The DS-CP3201 includes:

1) circuit board  2) power supply  3) circuit board enclosure  4) 9 pin RS-232 cable

Assemble the Contact Closure Module

Remove the top cover from the enclosure and insert the circuit board by flexing the sides of the enclosure out as required. Do not put the top cover back on until connections have been made and proper operation is verified.

Connecting the Contact Closure Module

1) Mount the contact closure module near the touch screen PC. Leave the cover of the device off until all connections are made and proper operation is verified.

2) Connect the provided 9 pin com port cable to the port labeled “HOST” on contact closure.

3) Connect the other end of the RS-232 cable to a com port on the sound masking system PC.

3) Configure Privacy Manager software as described on the preceding page. The LED in the contact closure should flash red at the same rate as the interval set in the software. The contact closure module will read the contact open/closed status on the specified interval only.
Initial Installation and system configuration

Before installing the sound masking network you will require a drawing showing the location of DS8000s and speakers. In the case of a new project being shipped the DS8000s will be pre-configured and labeled. This means they must be installed in accordance with the drawings so that the system may be tuned and adjusted and so that the end user may manage the system at a later date.

The factory IP address for DS3002 and DS3008 devices is 192.168.100.5 - Transmit Bundle Number 2  Rec 0
The factory IP address for DS8000 devices is 192.168.100.6 through 192.168.100.200 - Rec Bundle Number 2
Control devices such as PCs or touchscreen devices are normally 192.168.100.220 through 192.168.100.250
Contact tech support if you have installation, relocation or system expansion questions.

Alternate configurations and applications

As previously described, the standard network configuration uses the internal sound masking generators in the DS8000s. It is also possible to use the masking generators in the DS3002/DS3008 to broadcast sound masking and paging to groups of DS8000s. if no paging or music signals are required, an addressable network of DS8000s can be used without a network broadcaster.

Additional DS3008 and DS3002 processors may also be used in complex networks to provide Analog to Digital or Digital to Analog conversion used to introduce or extract audio signals to or from the digital audio network.

System configuration files

The following files are located in the directory where Privacy Manager is installed.

The location is C:\Dynasound\PrivacyManager.
Four files contain configuration and IP settings:  DSIControl.ini , Profiles.dat , SoftStart.dat , maskingSchedules.dat

Compatibility with other Products

DynasoundPRO audio networking products use CobraNet™ and as such are compatible with CobraNet products from other pro audio manufacturers. Such products include network audio amplifiers, network ready microphone jacks and more.

DynasoundPRO audio networking products are controlled with industry standard SNMP technology permitting interface with a variety of industrial control products. Contact tech support for more information.
## Specifications

### DS3002

**Inputs:**
- 2 ea. balanced inputs using pluggable connectors and CobraNet™
  - Each input with 6 band EQ and compressor - 20K ohm impedance

**Outputs:**
- 2 ea. balanced outputs using pluggable connectors and CobraNet™

**Mixers:**
- 6x8 matrix mixer

**Sound masking Generators:**
- 4 ea. internal sound masking generators with 1/3 octave band EQ, selectable 6/12 dB per octave roll-off low pass and selectable high pass filters.

**Input power:**
- 120 volts AC 60 Hz  21.5 watts
**Power Consumption:**
- 16 volts, 1000 mA. - Use only with provided power supply

**Dimensions:**
- Standard 19” NEMA Equipment Rack Mount - depth 8 inches
**Max. Operating Temperature:**
- 40C

### DS3008

**Inputs:**
- 8 ea. balanced inputs using pluggable connectors and CobraNet™
  - Each input with 6 band EQ and compressor - 20K ohm impedance

**Outputs:**
- 8 ea. balanced outputs using pluggable connectors and CobraNet™

**Mixers:**
- 12x8 matrix mixer

**Sound masking Generators:**
- 4 ea. internal sound masking generators with 1/3 octave band EQ, selectable 6/12 dB per octave roll-off low pass and selectable high pass filters.

**Input power:**
- 120 volts AC 60 Hz  21.5 watts
**Power Consumption:**
- 16 volts, 1000 mA. - Use only with provided power supply

**Dimensions:**
- Standard 19” NEMA Equipment Rack Mount - depth 8 inches
**Max. Operating Temperature:**
- 40C

### DS8000

**Inputs:**
- CobraNet™ networked digital audio each input with 7 band EQ

**Output:**
- 8 ea. channels - 1 watt @ 8 ohms using pluggable connectors

**Mixers:**
- (firmware v3) 12x8 matrix mixer
- (firmware v4) 9x8 matrix mixer

**Sound masking Generators:**
- (firmware v3) 4 ea. internal sound masking generators with 1/3 octave band EQ, selectable 6/12 dB per octave roll-off low pass and high pass filters.

**Input power:**
- Power over Ethernet Typical power consumption 3 -5 watts. Max 12 watts.

**Dimensions:**
- 7.25 “ long x 5.25 inches wide x 1.25 inches deep.
**Max. Operating Temperature:**
- 40C
System notes:

Starting IP address: 192.168.100.____
Ending IP address: 192.168.100.____
Non-Used IP addresses: ______________________

2nd Starting IP address: 192.168.101.____
2nd Ending IP address: 192.168.101.____
Non-Used IP addresses: ______________________

Audio channels (paging music and masking):

network channel 1: __________________________
network channel 2: __________________________
network channel 3: __________________________
network channel 4: __________________________
network channel 5: __________________________
network channel 6: __________________________
network channel 7: masking A_______________
network channel 8: masking B_______________
Tech support

Software updates and the latest documentation can be downloaded from the Cambridge Sound Management website. Go to http://cambridgesound.com/dynasound-privacy-manager-software/

For additional support:

Contact Cambridge Sound Management or Biamp.